
Keysight N8841A CAUI-4 
Compliance Test Application

Methods of 
Implementation



 

2 Keysight N8841A CAUI-4 Compliance Test Application Methods of Implementation

Notices
© Keysight Technologies, Inc. 2014-2016

No part of this manual may be reproduced in 
any form or by any means (including 
electronic storage and retrieval or 
translation into a foreign language) without 
prior agreement and written consent from 
Keysight Technologies, Inc. as governed by 
United States and international copyright 
laws.

Revision
Version 01.00.0000 or greater

Ed ition
May 4, 2016

Available in electronic format only

Published by:
Keysight Technologies, Inc.
1900 Garden of the Gods Road
Colorado Springs, CO 80907 USA

Warranty
The material contained in this document is 
provided "as is," and is subject to being 
changed, without notice, in future ed itions. 
Further, to the maximum extent permitted 
by appl icable law, Keysight d isclaims all 
warranties, either express or implied, with 
regard to this manual and any information 
contained herein, includ ing but not l imited 
to the implied warranties of 
merchantabil ity and fitness for a particular 
purpose. Keysight shall not be l iable for 
errors or for incidental or consequential 
damages in connection with the furnishing, 
use, or performance of this document or of 
any information contained herein. Should 
Keysight and the user have a separate 
written agreement with warranty terms 
covering the material in this document that 
confl ict with these terms, the warranty 
terms in the separate agreement shall 
control.

Technology License
The hardware and/or software described in 
this document are furnished under a license 
and may be used or copied only in 
accordance with the terms of such license.

U.S. Government Rights
The Software is "commercial computer 
software," as defined by Federal Acquisition 
Regulation ("FAR") 2.101. Pursuant to FAR 
12.212 and 27.405-3 and Department of 
Defense FAR Supplement ("DFARS") 
227.7202, the U.S. government acquires 
commercial computer software under the 
same terms by which the software is 
customarily provided to the public. 
Accordingly, Keysight provides the Software 
to U.S. government customers under its 
standard commercial license, which is 
embodied in its End User License Agreement 
(EULA), a copy of which can be found at 
www.keysight.com/find/sweula. The 
license set forth in the EULA represents the 
exclusive authority by which the U.S. 
government may use, modify, distribute, or 
disclose the Software. The EULA and the 
license set forth therein, does not require or 
permit, among other things, that Keysight: 
(1) Furnish technical information related to 
commercial computer software or 
commercial computer software 
documentation that is not customarily 
provided to the public; or (2) Relinquish to, 
or otherwise provide, the government rights 
in excess of these rights customarily 
provided to the public to use, modify, 
reproduce, release, perform, display, or 
disclose commercial computer software or 
commercial computer software 
documentation. No additional government 
requirements beyond those set forth in the 
EULA shall apply, except to the extent that 
those terms, rights, or licenses are explicitly 
required from all providers of commercial 
computer software pursuant to the FAR and 
the DFARS and are set forth specifically in 
writing elsewhere in the EULA. Keysight 
shall be under no obligation to update, 
revise or otherwise modify the Software. 
With respect to any technical data as 
defined by FAR 2.101, pursuant to FAR 
12.211 and 27.404.2 and DFARS 227.7102, 
the U.S. government acquires no greater 
than Limited Rights as defined in FAR 27.401 
or DFAR 227.7103-5 (c), as applicable in any 
technical data.

Safety Notices

CAUTION

A CAUTION notice denotes a hazard. 
It calls attention to an operating 
procedure, practice, or the like that, 
if not correctly performed or 
adhered to, could result in damage 
to the product or loss of important 
data. Do not proceed beyond a 
CAUTION notice until the indicated 
conditions are fully understood and 
met.

WARNING

A WARNING notice denotes a 
hazard. It calls attention to an 
operating procedure, practice, or 
the l ike that, if not correctly 
performed or adhered to, could 
resul t in personal injury or death. 
Do not proceed beyond a WARNING 
notice until the ind icated 
conditions are fully understood and 
met.

http://www.keysight.com/find/sweula


 

Keysight N8841A CAUI-4 Compliance Test Application Methods of Implementation 3

CAUI-4 Compliance Test Application—At a Glance
The Keysight N8841A CAUI-4 Compliance Test Application is an Ethernet test 
solution that covers the electrical timing parameters for CAUI-4 specification (IEEE 
802.3bm Sections 83D and 83E).

The CAUI-4 Compliance Test Application:

• Lets you select individual or multiple tests to run.

• Lets you identify the device being tested and its configuration.

• Shows you how to make oscilloscope connections to the device under test.

• Automatically checks for proper oscilloscope configuration.

• Automatically sets up the oscilloscope for each test.

• Allows you to determine the number of trials for each test.

• Provides detailed information of each test that has been run. The result of 
maximum 64 worst trials can be displayed at any one time.

• Creates a printable HTML report of the tests that have been run. This report 
includes pass/fail limits, margin analysis, and screen shots.

Required
Equipment and

Software

In order to run the CAUI-4 automated tests, you need the following equipment and 
software:

Product Description Notes

DSO/DSAZ634A Infiniium Oscilloscope: 63 GHz 63 GHz and above

N8841A-1FP, or CAUI-4 Compliance Test Software, fixed 
perpetual license

Required

N5435A-102 CAUI-4 Compliance Test Software, server based 
license

N8841A-7FP, or Switch matrix option, fixed perpetual license Optional

N5435A-716 Switch matrix option, server based license

E2688A-1FP Serial data analysis software Required

N5400A-1FP EZJIT Plus Software Required

N5465A-1FP InfiniiSim Software – Advanced license Recommended for probe 
correction

N5234A Network analyzer, 43.5 GHz Required for up to 30 Gb/s 
return loss testing
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1 Installing the N8841A CAUI-4 
Compliance Test Application

Installing the Software / 8
Installing the License Key / 9

If you purchased the N8841A Compliance Test Application separate from your 
Infiniium oscilloscope, you need to install the software and license key.
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1 Installing the N8841A CAUI-4 Compliance Test Application
 

Installing the Software

1 Make sure you have the minimum version of Infiniium oscilloscope software 
(see the N8841A release notes) by choosing Help > About Infiniium... from the 
main menu.

2 To obtain the N8841A Compliance Test Application, go to Keysight website: 
http://www.keysight.com/support/N8841A

3 The link for N8841A CAUI-4 Compliance Test Application will appear. 
Double-click on it and follow the instructions to download and install the 
application software.

http://www.keysight.com/find/N8841A
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Installing the License Key

1 Request a license code from Keysight by following the instructions on the 
Entitlement Certificate.

You will need the oscilloscope's "Option ID Number", which you can find in the 
Help > About Infiniium... dialog box.

2 After you receive your license code from Keysight, choose Util ities > Install Option 
License....

3 In the Install Option License dialog box, enter your license code and click Install 
License.

4 Click OK in the dialog box that tells you to restart the Infiniium oscilloscope 
application software to complete the license installation.

5 Click Close to close the Install Option License dialog box.

6 Choose File > Exit.

7 Restart the Infiniium oscilloscope application software to complete the license 
installation.
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1 Installing the N8841A CAUI-4 Compliance Test Application
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2 Preparing to Take 
Measurements

Calibrating the Oscilloscope / 12
Starting the Compliance Test Application / 13

Before running the automated tests, you should calibrate the oscilloscope and 
probe. No test fixture is required for this application. After the oscilloscope and 
probe have been calibrated, you are ready to start the N8841A CAUI-4 Compliance 
Test Application and perform the measurements.
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2 Preparing to Take Measurements
 

Calibrating the Oscilloscope

If you haven't already calibrated the oscilloscope, see Appendix A, “Calibrating the 
Infiniium Oscilloscope and Probe,” starting on page 63.

NOTE If the ambient temperature changes more than 5 degrees Celsius from the calibration 
temperature, internal calibration should be performed again. The delta between the 
calibration temperature and the present operating temperature is shown in the Util ities > 
Calibration menu.

NOTE If you switch cables between channels or other oscilloscopes, it is necessary to perform cable 
and probe calibration again. Keysight recommends that, once calibration is performed, you 
label the cables with the channel on which they were calibrated.
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Starting the Compliance Test Application

1 Ensure that the Device Under Test (DUT) is operating and set to desired test 
modes.

2 To start the Compliance Test Application: From the Infiniium oscilloscope's 
main menu, choose Analyze > Automated Test Apps > N8841A CAUI-4 Test App.

The task flow pane, and the tabs in the main pane, show the steps you take in 
running the automated tests:

Figure 1 N8841A CAUI-4 Compliance Test Application Main Window
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2 Preparing to Take Measurements
 

Set Up Lets you identify and set up the test environment, including information 
about the device under test.
Select the oscilloscope channel pair that will be used.
The Multi-Lane Option enables you to choose to test a single lane or with 
the switch matrix.
The Device Identifier, User Description, and Comments are all printed in 
the final HTML report.
Set up InfiniiSim with the InfiniiSim Setup button.
With the Set Channel skew button, the channels can be visually adjusted 
and skewed.
The Saved Waveform Setup button enables easy setup of saved 
waveforms. When waveforms are set up, the application will make all 
measurements on the saved waveforms.
Select PNA or ENA; then click Connect PNA/ENA to make the instrument 
connection.

Select Tests Lets you select the tests you want to run. The tests are organized 
hierarchically so you can select all tests in a group. After tests are run, 
status indicators show which tests have passed, failed, or not been run, 
and there are indicators for the test groups.

Configure Lets you configure test parameters (for example, channels used in test, 
Number of UI to test, oscilloscope bandwidth, etc.).

Connect Shows you how to connect the oscilloscope to the device under test for 
the tests that are to be run.

Run Tests Starts the automated tests. If the connections to the device under test 
need to be changed while multiple tests are running, the tests pause, show 
you how to change the connection, and wait for you to confirm that the 
connections have been changed before continuing.

Automation Lets you construct scripts of commands that drive execution of the 
application.

Resul ts Contains more detailed information about the tests that have been run. You 
can change the thresholds at which marginal or critical warnings appear.

HTML Report Shows a compliance test report that can be printed.
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3 CAUI-4 Transmitter 
Characteristics at TP0a

Main Voltage Measurements / 16
Jitter and Data Rate Measurements / 20
Transmitter Output Waveform Measurements / 23
Pre- and Post-Equalization Tests / 26
Return Loss ENA/PNA Measurements / 33

This section provices the Methods of Implemenation for the CAUI-4 Transmitter 
Characteristics at TP0a as specified in IEEE802.3bm Table 83D-1. Measurements 
are made at TP0a.
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3 CAUI-4 Transmitter Characteristics at TP0a
 

Main Voltage Measurements

This section provides the Methods of Implementation (MOIs) for the CAUI-4 Main 
Voltage Measurements using a Keysight Infiniium oscilloscope and the N8841A 
Compliance Test Application.

Probing and
Connection

You can use any of the oscilloscope channels as Signal source channel; however, 
for proper BW, use the Real Edge channels. Select lane options in the Set Up tab. 
You can identify the channels used for the measurement signal in the Set Up tab of 
the Compliance Test Application.

Test Procedure 1 Start the automated test application as described in "Starting the Compliance 
Test Application" on page 13.

2 Connect the probes to the signals on the DUT.

3 Connect the oscilloscope probes or cables to the channel(s) of the oscilloscope 
that you have set up in the Configuration tab.

4 In the Test application, click the Set Up tab. Select Measurement Option, Lane 
Option, and Channels.

5 Set up Switch matrix (if used) by clicking on the Switch Matrix Setup button.

6 Set up InfiniiSim if needed.

7 Type in or select the Device Identifier as well as the User Description from the 
drop-down list. Enter your comments in the Comments text box.

8 Click the Select Tests tab and check the tests you want to run. Check the parent 
node or group to check all the available tests within the group.

Figure 2 Probing for Main Voltage Measurements
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Specifications The CAUI-4 specifications can be found in IEEE 802.3bm section 83D.

• Differential Peak-to-Peak Output Voltage with TX disabled (max 30 mV).

• DC Common Mode Output Voltage (0 to 1.9 V).

• AC Common Mode Output Voltage (max 12 mV).

• Differential Peak-to-Peak Output Voltage (max 1200 mV).

Differential Peak-to-Peak Output Voltage Test with TX disabled

The purpose of this test is to verify that when TX is disabled the peak-to-peak 
voltage is less than 30 mV.

PASS Condition The max peak-to-peak voltage is less than 30 mV.

Measurement
Algorithm

1 Obtain sample or acquire signal data.

2 Check that signal is truly with TX disabled (no valid data transitions).

3 Measure peak-to-peak voltage of the signal.

Figure 3 Selecting Main Voltage Measurement Tests
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3 CAUI-4 Transmitter Characteristics at TP0a
 

4 Compare the max peak-to-peak voltage to 30 mV.

DC Common Mode Output Voltage Test

The purpose of this test is to verify that the common mode signal of the differential 
pair is between 0 to 1.9 V.

PASS Condition The signal is between 0 to 1.9 V.

Measurement
Algorithm

1 Obtain sample or acquire signal data.

2 Verify that there is a signal and that the connection is dual-single ended.

3 Measure the peak-to-peak voltage of the addition of the channel 1 and 3 or 
channel 2 and 4.

4 Compare the voltage measurement to 0 to 1.9 V.

AC Common Mode Output Voltage Test

The purpose of this test is to verify that the common mode signal of the differential 
pair rms voltage does not exceed 12 mV.

PASS Condition The signal is less than 12 mV.

Measurement
Algorithm

1 Obtain sample or acquire signal data.

2 Verify that there is a signal and that the connection is dual-single ended.

3 Measure the peak-to-peak voltage of the addition of the channel 1 and 3 or 
channel 2 and 4.

4 Compare the voltage measurement to 12 mV.

Differential Peak-to-Peak Output Voltage Test

The purpose of this test is to verify that the peak-to-peak voltage of the differential 
signal on a PRBS9 pattern is less than 1200 mV.

PASS Condition The differential signal max peak-to-peak voltage on a PRBS9 pattern is less than 
1200 mV.

NOTE This measurement can be done with a dual-single ended connection only; it cannot be done 
with a differential probing connection.

NOTE This measurement can be done with a dual-single ended connection only; it cannot be done 
with a differential probing connection.
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Measurement
Algorithm

1 Obtain sample or acquire signal data.

2 Verify that there is a signal is connected and has a PRBS9 pattern.

3 Measure the peak-to-peak voltage of the differential signal of DUT+ and DUT-.

4 Compare the max peak-to-peak voltage to 1200 mV.
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3 CAUI-4 Transmitter Characteristics at TP0a
 

Jitter and Data Rate Measurements

This section provides the Methods of Implementation (MOIs) for the Jitter and 
Data Rate Measurements using a Keysight Infiniium oscilloscope and the N8841A 
CAUI-4 Compliance Test Application.

Probing and
Connection

You can use any of the oscilloscope channels as Signal source channel; however, 
for proper BW, use the Real Edge channels. Select lane options in the Set Up tab. 
You can identify the channels used for the measurement signal in the Set Up tab of 
the Compliance Test Application.

Test Procedure 1 Start the automated test application as described in "Starting the Compliance 
Test Application" on page 13.

2 Connect the probes to the signals on the DUT.

3 Connect the oscilloscope probes or cables to the channel(s) of the oscilloscope 
that you have set up in the Configuration tab.

4 In the Test application, click the Set Up tab. Select Measurement Option, Lane 
Option, and Channels.

5 Set up Switch matrix (if used) by clicking on the Switch Matrix Setup button.

6 Set up InfiniiSim if needed.

7 Type in or select the Device Identifier as well as the User Description from the 
drop-down list. Enter your comments in the Comments text box.

8 Click the Select Tests tab and check the tests you want to run. Check the parent 
node or group to check all the available tests within the group.

Figure 4 Probing for Jitter and Data Rate Measurements
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Specifications The CAUI-4 specifications can be found in IEEE 802.3bm section 83D.

• Signaling Rate (25.78125 ±100 ppm GBd).

• Max output jitter.

• Even-Odd Jitter (max 35 mUI)

• Bounded Uncorrelated Jitter (max 100 mUI)

• Total Uncorrelated Jitter (max 260 mUI)

Signaling Rate

The purpose of this test is to verify that the data rate mean is between 25.78125 
±100 ppm GBd.

PASS Condition The mean signaling rate is between 25.78125 ±100 ppm GBd.

Figure 5 Selecting Jitter and Data Rate Tests
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Measurement
Algorithm

1 Obtain sample or acquire signal data.

2 Check that signal is connected and data pattern exists (PRBS9 must be used 
for this test).

3 Set memory depth to capture the number or UI set in the Configure tab.

4 Set data rate measurement to semi-automatic 25.78125 Gb/s.

5 Measure min, max, mean data rate.

6 Report min and max values.

7 Compare and report the mean data rate value to 25.78125 ±100 ppm GBd.

Jitter (Even-Odd Jitter, Bounded Uncorrelated Jitter, Total Uncorrelated 
Jitter)

The purpose of this test is to verify that differential signal's Even-Odd Jitter is less 
that 35 mUI, Bounded Uncorrelated Jitter is less than 100 mUI, and Random Jitter 
is less than 10 mUI. If all tests are selected, all tests are run on a single 
measurement. Each test can be run individually by selecting any or some of the 
tests.

PASS Conditions Even-Odd Jitter is less than 35 mUI, BUJ is less than 100 mUI, and Total 
Uncorrelated Jitter is less than 260 mUI.

Measurement
Algorithm

1 Obtain sample or acquire signal data.

2 Check that signal is connected and data pattern exists (PRBS9 must be used 
for this test).

3 Set memory depth to capture the number or UI set in the Configure tab.

4 Set clock recovery to OJTF First Order PLL with Nominal Data Rate 
25.78125 Gb/s and Loop Bandwidth to 10 MHz.

5 Using EZJIT, measure Even-Odd Jitter, BUJ, and calculate Total Uncorrelated 
Jitter = 7.9*ERJ + EBUJ.

6 Compare and report the values to their respective maximum specification.
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Transmitter Output Waveform Measurements

This section provides the Methods of Implementation (MOIs) for the Transmitter 
Output Waveform Measurements for Transition Time using a Keysight Infiniium 
oscilloscope and the N8841A CAUI-4 Compliance Test Application.

Probing and
Connection

You can use any of the oscilloscope channels as Signal source channel; however, 
for proper BW, use the Real Edge channels. Select lane options in the Set Up tab. 
You can identify the channels used for the measurement signal in the Set Up tab of 
the Compliance Test Application.

Test Procedure 1 Start the automated test application as described in "Starting the Compliance 
Test Application" on page 13.

2 Connect the probes to the signals on the DUT.

3 Connect the oscilloscope probes or cables to the channel(s) of the oscilloscope 
that you have set up in the Configuration tab.

4 In the Test application, click the Set Up tab. Select Measurement Option, Lane 
Option, and Channels.

5 Set up Switch matrix (if used) by clicking on the Switch Matrix Setup button.

6 Set up InfiniiSim if needed.

7 Type in or select the Device Identifier as well as the User Description from the 
drop-down list. Enter your comments in the Comments text box.

8 Click the Select Tests tab and check the tests you want to run. Check the parent 
node or group to check all the available tests within the group.

Figure 6 Probing for Transmitter output Waveform Measurements
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Specifications The CAUI-4 specifications can be found in IEEE 802.3bm section 83D.

• Steady State Voltage Vf (400 to 600 mV)

• Linear Fit Pulse Peak (0.71 * Vf)

Steady State Voltage Vf

The purpose of this test is to verify that the Steady State Voltage as described in 
section 85.8.3.3 is between 0.4 and 0.6 V.

PASS Condition The Steady State Voltage is between 0.4 and 0.6 V.

Measurement
Algorithm

1 Check that signal is connected and the proper data pattern exists. (PRBS9 is 
required for this test)

2 Set memory depth and sample rate to capture the 511 bits of the PRBS9 
pattern for M= Np+1 points per bit.

3 Calculate Vf using the equations in section 85.8.3.3.5. The result value is the 
sum of the columns of p(k)/M.

Figure 7 Selecting Transmitter Output Waveform Test
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4 Compare and report the result to 0.4 to 0.6 V.

Linear Fit Pulse Peak

The purpose of this test is to verify that the Linear Fit Pulse as described in section 
85.8.3.3 is greater than the Vf * 0.71.

PASS Condition The Linear Fit Pulse is greater than Vf * 0.71.

Measurement
Algorithm

1 Check that signal is connected and the proper data pattern exists. (PRBS9 is 
required for this test)

2 Set memory depth and sample rate to capture the 511 bits of the PRBS9 
pattern for M= Np+1 points per bit.

3 Calculate Linear Fit Pulse using the equations in section 85.8.3.3.5. The result it 
the peak value of p(k).

4 Compare and report the result to 0.71* Vf.
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Pre- and Post-Equalization Tests

This section provides the Methods of Implementation (MOIs) for the Pre- and 
Post-Equalization Tests using a Keysight Infiniium oscilloscope and the N8841A 
Compliance Test Application.

Probing and
Connection

You can use any of the oscilloscope channels as Signal source channel; however, 
for proper BW, use the Real Edge channels. Select lane options in the Set Up tab. 
You can identify the channels used for the measurement signal in the Set Up tab of 
the Compliance Test Application.

Test Procedure 1 Start the automated test application as described in "Starting the Compliance 
Test Application" on page 13.

2 Connect the probes to the signals on the DUT.

3 Connect the oscilloscope probes or cables to the channel(s) of the oscilloscope 
that you have set up in the Configuration tab.

4 In the Test application, click the Set Up tab. Select Measurement Option, Lane 
Option, and Channels.

5 Set up Switch matrix (if used) by clicking on the Switch Matrix Setup button.

6 Set up InfiniiSim if needed.

7 Type in or select the Device Identifier as well as the User Description from the 
drop-down list. Enter your comments in the Comments text box.

8 Click the Select Tests tab and check the tests you want to run. Check the parent 
node or group to check all the available tests within the group.

Figure 8 Probing for Pre- and Post-Equalization Tests
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Pre-cursor equalization Local_eq_cm1(0)

The purpose of this test is to verify that the Pre-cursor equalization ratio is 0±0.04.

PASS Condition When the Pre-cursor equalization with weight Local_eq_cm1 = 0, C(-1) / (|C(-1)| + 
|C(0)| + |C(1)|) must be within 0±0.04.

Measurement
Algorithm

1 Request transmitter to be set to "PRESET" condition.

2 Set memory depth to capture one full PRBS9 pattern and scale.

3 Calculate linear fit pulse response at "PRESET" condition.

4 Define matrix Rm using Equation (92-4) from IEEE 802.3.

5 Request to change the eq setting to Pre-cursor equalization with weight 
local_eq_cm1 = 0.

6 Calculate linear fit pulse response.

7 Calculate coefficients with equation (92-5).

8 Calculate precursor ratio C(-1) / (|C(-1)| + |C(0)| + |C(1)|).

Figure 9 Selecting Pre- and Post-Equalization Tests
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9 Report and compare the value calculated in step 8 with 0±0.04.

Pre-cursor equalization Local_eq_cm1(1)

The purpose of this test is to verify that the Pre-cursor equalization ratio is 
-0.05±0.04.

PASS Condition When the Pre-cursor equalization with weight Local_eq_cm1 = 1, C(-1) / (|C(-1)| + 
|C(0)| + |C(1)|) must be within -0.05±0.04.

Measurement
Algorithm

1 Request transmitter to be set to "PRESET" condition. (If not already 
measured/calculated in a previous equalization test of the same trial – else 
start at step 5).

2 Set memory depth to capture one full PRBS9 pattern and scale.

3 Calculate linear fit pulse response at "PRESET" condition.

4 Define matrix Rm using Equation (92-4) from IEEE 802.3.

5 Request to change the eq setting to Pre-cursor equalization with weight 
local_eq_cm1 = 1.

6 Calculate linear fit pulse response.

7 Calculate coefficients with equation (92-5).

8 Calculate precursor ratio C(-1) / (|C(-1)| + |C(0)| + |C(1)|).

9 Report and compare the value calculated in step 8 with -0.05±0.04.

Pre-cursor equalization Local_eq_cm1(2)

The purpose of this test is to verify that the Pre-cursor equalization ratio is 
-0.1±0.04.

PASS Condition When the Pre-cursor equalization with weight Local_eq_cm1 = 2, C(-1) / (|C(-1)| + 
|C(0)| + |C(1)|) must be within -0.1±0.04.

Measurement
Algorithm

1 Request transmitter to be set to "PRESET" condition. (If not already 
measured/calculated in a previous equalization test of the same trial – else 
start at step 5).

2 Set memory depth to capture one full PRBS9 pattern and scale.

3 Calculate linear fit pulse response at "PRESET" condition.

4 Define matrix Rm using Equation (92-4) from IEEE 802.3.

5 Request to change the eq setting to Pre-cursor equalization with weight 
local_eq_cm1 = 2.

6 Calculate linear fit pulse response.

7 Calculate coefficients with equation (92-5).

8 Calculate precursor ratio C(-1) / (|C(-1)| + |C(0)| + |C(1)|).

9 Report and compare the value calculated in step 8 with -0.1±0.04.
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Pre-cursor equalization Local_eq_cm1(3)

The purpose of this test is to verify that the Pre-cursor equalization ratio is 
-0.15±0.04.

PASS Condition When the Pre-cursor equalization with weight Local_eq_cm1 = 3, C(-1) / (|C(-1)| + 
|C(0)| + |C(1)|) must be within -0.15±0.04.

Measurement
Algorithm

1 Request transmitter to be set to "PRESET" condition. (If not already 
measured/calculated in a previous equalization test of the same trial – else 
start at step 5).

2 Set memory depth to capture one full PRBS9 pattern and scale.

3 Calculate linear fit pulse response at "PRESET" condition.

4 Define matrix Rm using Equation (92-4) from IEEE 802.3.

5 Request to change the eq setting to Pre-cursor equalization with weight 
local_eq_cm1 = 3.

6 Calculate linear fit pulse response.

7 Calculate coefficients with equation (92-5).

8 Calculate precursor ratio C(-1) / (|C(-1)| + |C(0)| + |C(1)|).

9 Report and compare the value calculated in step 8 with -0.15±0.04.

Post-cursor equalization Local_eq_c1(0)

The purpose of this test is to verify that the Post-cursor equalization ratio is 
0±0.04.

PASS Condition When the Post-cursor equalization with weight Local_eq_c1 = 0, C(1) / (|C(-1)| + 
|C(0)| + |C(1)|) must be within 0±0.04.

Measurement
Algorithm

1 Request transmitter to be set to "PRESET" condition. (If not already 
measured/calculated in a previous equalization test of the same trial – else 
start at step 5).

2 Set memory depth to capture one full PRBS9 pattern and scale.

3 Calculate linear fit pulse response at "PRESET" condition.

4 Define matrix Rm using Equation (92-4) from IEEE 802.3.

5 Request to change the eq setting to Post-cursor equalization with weight 
local_eq_c1 = 0.

6 Calculate linear fit pulse response.

7 Calculate coefficients with equation (92-5).

8 Calculate precursor ratio C(1) / (|C(-1)| + |C(0)| + |C(1)|).

9 Report and compare the value calculated in step 8 with 0±0.04.
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Post-cursor equalization Local_eq_c1(1)

The purpose of this test is to verify that the Post-cursor equalization ratio is 
-0.05±0.04.

PASS Condition When the Post-cursor equalization with weight Local_eq_c1 = 1, C(1) / (|C(-1)| + 
|C(0)| + |C(1)|) must be within -0.05±0.04.

Measurement
Algorithm

1 Request transmitter to be set to "PRESET" condition. (If not already 
measured/calculated in a previous equalization test of the same trial – else 
start at step 5).

2 Set memory depth to capture one full PRBS9 pattern and scale.

3 Calculate linear fit pulse response at "PRESET" condition.

4 Define matrix Rm using Equation (92-4) from IEEE 802.3.

5 Request to change the eq setting to Post-cursor equalization with weight 
local_eq_c1 = 1.

6 Calculate linear fit pulse response.

7 Calculate coefficients with equation (92-5).

8 Calculate precursor ratio C(1) / (|C(-1)| + |C(0)| + |C(1)|).

9 Report and compare the value calculated in step 8 with -0.05±0.04.

Post-cursor equalization Local_eq_c1(2)

The purpose of this test is to verify that the Post-cursor equalization ratio is 
-0.1±0.04.

PASS Condition When the Post-cursor equalization with weight Local_eq_c1 = 2, C(1) / (|C(-1)| + 
|C(0)| + |C(1)|) must be within -0.1±0.04.

Measurement
Algorithm

1 Request transmitter to be set to "PRESET" condition. (If not already 
measured/calculated in a previous equalization test of the same trial – else 
start at step 5).

2 Set memory depth to capture one full PRBS9 pattern and scale.

3 Calculate linear fit pulse response at "PRESET" condition.

4 Define matrix Rm using Equation (92-4) from IEEE 802.3.

5 Request to change the eq setting to Post-cursor equalization with weight 
local_eq_c1 = 2.

6 Calculate linear fit pulse response.

7 Calculate coefficients with equation (92-5).

8 Calculate precursor ratio C(1) / (|C(-1)| + |C(0)| + |C(1)|).

9 Report and compare the value calculated in step 8 with -0.1±0.04.
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Post-cursor equalization Local_eq_c1(3)

The purpose of this test is to verify that the Post-cursor equalization ratio is 
-0.15±0.04.

PASS Condition When the Post-cursor equalization with weight Local_eq_c1 = 3, C(1) / (|C(-1)| + 
|C(0)| + |C(1)|) must be within -0.15±0.04.

Measurement
Algorithm

1 Request transmitter to be set to "PRESET" condition. (If not already 
measured/calculated in a previous equalization test of the same trial – else 
start at step 5).

2 Set memory depth to capture one full PRBS9 pattern and scale.

3 Calculate linear fit pulse response at "PRESET" condition.

4 Define matrix Rm using Equation (92-4) from IEEE 802.3.

5 Request to change the eq setting to Post-cursor equalization with weight 
local_eq_c1 = 3.

6 Calculate linear fit pulse response.

7 Calculate coefficients with equation (92-5).

8 Calculate precursor ratio C(1) / (|C(-1)| + |C(0)| + |C(1)|).

9 Report and compare the value calculated in step 8 with -0.15±0.04.

Post-cursor equalization Local_eq_c1(4)

The purpose of this test is to verify that the Post-cursor equalization ratio is 
-0.2±0.04.

PASS Condition When the Post-cursor equalization with weight Local_eq_c1 = 4, C(1) / (|C(-1)| + 
|C(0)| + |C(1)|) must be within -0.2±0.04.

Measurement
Algorithm

1 Request transmitter to be set to "PRESET" condition. (If not already 
measured/calculated in a previous equalization test of the same trial – else 
start at step 5).

2 Set memory depth to capture one full PRBS9 pattern and scale.

3 Calculate linear fit pulse response at "PRESET" condition.

4 Define matrix Rm using Equation (92-4) from IEEE 802.3.

5 Request to change the eq setting to Post-cursor equalization with weight 
local_eq_c1 = 4.

6 Calculate linear fit pulse response.

7 Calculate coefficients with equation (92-5).

8 Calculate precursor ratio C(1) / (|C(-1)| + |C(0)| + |C(1)|).

9 Report and compare the value calculated in step 8 with -0.2±0.04.
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Post-cursor equalization Local_eq_c1(5)

The purpose of this test is to verify that the Post-cursor equalization ratio is 
-0.25±0.04.

PASS Condition When the Post-cursor equalization with weight Local_eq_c1 = 5, C(1) / (|C(-1)| + 
|C(0)| + |C(1)|) must be within -0.25±0.04.

Measurement
Algorithm

1 Request transmitter to be set to "PRESET" condition. (If not already 
measured/calculated in a previous equalization test of the same trial – else 
start at step 5).

2 Set memory depth to capture one full PRBS9 pattern and scale.

3 Calculate linear fit pulse response at "PRESET" condition.

4 Define matrix Rm using Equation (92-4) from IEEE 802.3.

5 Request to change the eq setting to Post-cursor equalization with weight 
local_eq_c1 = 5.

6 Calculate linear fit pulse response.

7 Calculate coefficients with equation (92-5).

8 Calculate precursor ratio C(1) / (|C(-1)| + |C(0)| + |C(1)|).

9 Report and compare the value calculated in step 8 with -0.25±0.04.
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Return Loss ENA/PNA Measurements

This section provides the Methods of Implementation (MOIs) for the Return Loss 
Measurements using a Keysight Infiniium oscilloscope, PNA or ENA, and the 
N8841A Compliance Test Application. The Compliance test application controls 
the PNA/ENA to set the test limits and run the test. The calibration must be done 
on the PNA/ENA.

Test Procedure 1 Start the automated test application as described in "Starting the Compliance 
Test Application" on page 13.

2 Calibrate the PNA or ENA.

3 In the Test application, click the Set Up tab. Select Measurement Option, Lane 
Option, and Channels.

4 Set up Switch matrix (if used) by clicking on the Switch Matrix Setup button.

5 Type in or select the Device Identifier as well as the User Description from the 
drop-down list. Enter your comments in the Comments text box.

6 Click the Select Tests tab and check the tests you want to run. Check the parent 
node or group to check all the available tests within the group.

7 Click Run. The test limits are automatically calculated.
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Figure 10 Selecting Return Loss Measurement
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Keysight N8841A CAUI-4 Compliance Test Application 
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4 CAUI-4 Host Output 
Characteristics at TP1a

Main Voltage Measurements / 36
Transition Time Measurements / 40
Signaling Rate and Eye Mask Measurements / 42
Return Loss ENA/PNA Measurements / 46

This section provides the Methods of Implemenation for the CAUI-4 Host Output 
Characteristics at TP1a as specified in IEEE802.3bm Table 83E-1. Measurements 
are made at TP1a.
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Main Voltage Measurements

This section provides the Methods of Implementation (MOIs) for the CAUI-4 Main 
Voltage Measurements using a Keysight Infiniium oscilloscope and the N8841A 
Compliance Test Application.

Probing and
Connection

You can use any of the oscilloscope channels as Signal source channel; however, 
for proper BW, use the Real Edge channels. Select lane options in the Set Up tab. 
You can identify the channels used for the measurement signal in the Set Up tab of 
the Compliance Test Application.

Test Procedure 1 Start the automated test application as described in "Starting the Compliance 
Test Application" on page 13.

2 Connect the probes to the signals on the DUT.

3 Connect the oscilloscope probes or cables to the channel(s) of the oscilloscope 
that you have set up in the Configuration tab.

4 In the Test application, click the Set Up tab. Select Measurement Option, Lane 
Option, and Channels.

5 Set up Switch matrix (if used) by clicking on the Switch Matrix Setup button.

6 Set up InfiniiSim if needed.

7 Type in or select the Device Identifier as well as the User Description from the 
drop-down list. Enter your comments in the Comments text box.

8 Click the Select Tests tab and check the tests you want to run. Check the parent 
node or group to check all the available tests within the group.

Figure 11 Probing for Main Voltage Measurements
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Specifications The CAUI-4 specifications can be found in IEEE 802.3bm section 83E.

• Differential Peak-to-Peak Output Voltage with TX disabled (max 35 mV).

• Differential Peak-to-Peak Output Voltage (max 900 mV).

• AC Common Mode Output Voltage (max 17.5 mV).

• DC Common Mode Output Voltage (-300 mV – 2.8V).

• Single-Ended Output Voltage (-400 mV – 3.3V).

Differential Peak-to-Peak Output Voltage Test with TX disabled

The purpose of this test is to verify that when TX is disabled the peak-to-peak 
voltage is less than 30 mV.

PASS Condition The max peak-to-peak voltage is less than 35 mV.

Measurement
Algorithm

1 Obtain sample or acquire signal data.

2 Check that signal is truly with TX disabled (no valid data transitions).

Figure 12 Selecting Main Voltage Measurement Tests
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3 Measure peak-to-peak voltage of the signal.

4 Compare the max peak-to-peak voltage to 35 mV.

Differential Peak-to-Peak Output Voltage Test

The purpose of this test is to verify that the peak-to-peak voltage of the differential 
signal on a SQ8 or PRBS9 pattern is less than 900 mV.

PASS Condition The differential signal max peak-to-peak voltage on a SQ8 or PRBS9 pattern is 
less than 900 mV.

Measurement
Algorithm

1 Obtain sample or acquire signal data.

2 Verify that there is a signal is connected and has a SQ8 or PRBS9 pattern.

3 Measure the peak-to-peak voltage of the differential signal of DUT+ and DUT-.

4 Compare the max peak-to-peak voltage to 900 mV.

AC Common Mode Output Voltage Test

The purpose of this test is to verify that the common mode signal of the differential 
pair rms voltage does not exceed 17.5 mV.

PASS Condition The signal is less than 17.5 mV.

Measurement
Algorithm

1 Obtain sample or acquire signal data.

2 Verify that there is a signal and that the connection is dual-single ended.

3 Measure the peak-to-peak voltage of the addition of the channel 1 and 3 or 
channel 2 and 4.

4 Compare the voltage measurement to 17.5 mV.

DC Common Mode Output Voltage Test

The purpose of this test is to verify that the common mode signal of the differential 
pair is between -300 mV to 2.8 V.

PASS Condition The signal is between -300 mV to 2.8 V.

NOTE This measurement can be done with a dual-single ended connection only; it cannot be done 
with a differential probing connection.

NOTE This measurement can be done with a dual-single ended connection only; it cannot be done 
with a differential probing connection.
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Measurement
Algorithm

1 Obtain sample or acquire signal data.

2 Verify that there is a signal and that the connection is dual-single ended.

3 Measure the peak-to-peak voltage of the addition of the channel 1 and 3 or 
channel 2 and 4.

4 Compare the voltage measurement to -300 mV to 2.8V.

Single-Ended Output Voltage Test

The purpose of this test is to verify that the minimum voltage of a single-ended 
signal is >-400 mV and the maximum voltage is <3.3 V.

PASS Condition The minimum single-ended voltage is >-400 mV and the maximum single-ended 
voltage is <3.3 V.

Measurement
Algorithm

1 Obtain sample or acquire signal data.

2 Verify that there is a signal and that the connection is dual-single ended.

3 Measure the min and max voltage of each single-ended signal.

4 Compare the voltage measurements to -400 mV to 3.3 V.

NOTE This measurement can be done with a dual-single ended connection only; it cannot be done 
with a differential probing connection.
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Transition Time Measurements

This section provides the Methods of Implementation (MOIs) for the CAUI-4 
Transition Time Measurements using a Keysight Infiniium oscilloscope and the 
N8841A Compliance Test Application.

Probing and
Connection

You can use any of the oscilloscope channels as Signal source channel; however, 
for proper BW, use the Real Edge channels. Select lane options in the Set Up tab. 
You can identify the channels used for the measurement signal in the Set Up tab of 
the Compliance Test Application.

Test Procedure 1 Start the automated test application as described in "Starting the Compliance 
Test Application" on page 13.

2 Connect the probes to the signals on the DUT.

3 Connect the oscilloscope probes or cables to the channel(s) of the oscilloscope 
that you have set up in the Configuration tab.

4 In the Test application, click the Set Up tab. Select Measurement Option, Lane 
Option, and Channels.

5 Set up Switch matrix (if used) by clicking on the Switch Matrix Setup button.

6 Set up InfiniiSim if needed.

7 Type in or select the Device Identifier as well as the User Description from the 
drop-down list. Enter your comments in the Comments text box.

8 Click the Select Tests tab and check the tests you want to run. Check the parent 
node or group to check all the available tests within the group.

Figure 13 Probing for Transition Time Measurements
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Specifications The CAUI-4 specifications can be found in IEEE 802.3bm section 83E.

• Minimum Output Rise Time (20%-80%) (min 10 ps).

• Minimum Output Fall Time (20%-80%) (min 10 ps).

Minimum Output Rise and Fall Time

The purpose of this test is to verify that the minimum rise and fall times are 10 ps.

PASS Condition The min rise and fall times are greater than 10 ps.

Measurement
Algorithm

1 Obtain sample or acquire signal data.

2 Verify signal is SQ8.

3 Measure rise and fall times from 20% to 80% of signal amplitude.

4 Compare the min rise and fall times to 10 ps.

Figure 14 Selecting Transition Time Tests



42 Keysight N8841A CAUI-4 Compliance Test Application Methods of Implementation

4 CAUI-4 Host Output Characteristics at TP1a
 

Signaling Rate and Eye Mask Measurements

This section provides the Methods of Implementation (MOIs) for the Signaling Rate 
and Eye Mask Measurements using a Keysight Infiniium oscilloscope and the 
N8841A CAUI-4 Compliance Test Application.

Probing and
Connection

You can use any of the oscilloscope channels as Signal source channel; however, 
for proper BW, use the Real Edge channels. Select lane options in the Set Up tab. 
You can identify the channels used for the measurement signal in the Set Up tab of 
the Compliance Test Application.

Test Procedure 1 Start the automated test application as described in "Starting the Compliance 
Test Application" on page 13.

2 Connect the probes to the signals on the DUT.

3 Connect the oscilloscope probes or cables to the channel(s) of the oscilloscope 
that you have set up in the Configuration tab.

4 In the Test application, click the Set Up tab. Select Measurement Option, Lane 
Option, and Channels.

5 Set up Switch matrix (if used) by clicking on the Switch Matrix Setup button.

6 Set up InfiniiSim if needed.

7 Type in or select the Device Identifier as well as the User Description from the 
drop-down list. Enter your comments in the Comments text box.

8 Click the Select Tests tab and check the tests you want to run. Check the parent 
node or group to check all the available tests within the group.

Figure 15 Probing for Signaling Rate and Eye Mask Measurements
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Specifications The CAUI-4 specifications can be found in IEEE 802.3bm section 83E.

• Signaling Rate (25.78125 ±100 ppm GBd).

• Eye Mask.

• Eye Height A (min 95 mV)

• Eye Width (min 460 mUI)

• Eye Height B (min 80 mV)

Signaling Rate

The purpose of this test is to verify that the data rate mean is between 25.78125 
±100 ppm GBd.

PASS Condition The mean signaling rate is between 25.78125 ±100 ppm GBd.

Figure 16 Selecting Signaling Rate and Eye Mask Measurements
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Measurement
Algorithm

1 Obtain sample or acquire signal data.

2 Check that signal is connected and data pattern exists (PRBS9 must be used 
for this test).

3 Set memory depth to capture the number or UI set in the Configure tab.

4 Set data rate measurement to semi-automatic 25.78125 Gb/s.

5 Measure min, max, mean data rate.

6 Report min and max values.

7 Compare and report the mean data rate value to 25.78125 ±100 ppm GBd.

Eye Height A and Eye Width

The purpose of this test is to verify that one of the following CTLE settings Eye 
Height is greater than 95 mV and Eye Width is greater than 460 mUI. CTLE 
settings options are:

1 Host Recommended CTLE

2 1 dB lower than optimal CTLE

3 1 dB higher than optimal CTLE

PASS Condition The Eye Height measured is greater than 95 mV.

Measurement
Algorithm

1 To automatically find the optimal CTLE setting, first run the Find Optimal CTLE Eye 
Opening test unter Util ities (in the Select Tests tab). To manually set the optimal 
CTLE setting, select the setting under Use Optimized CTLE for Eye Opening in the 
Configure tab.

2 Select which CTLE setting to test in the Config tab (Host Recommended CTLE, 
1 dB lower than optimal CTLE, or 1 dB higher than optimal CTLE).

3 Obtain sample or acquire signal data.

4 Set memory depth to capture the number or UI set in the Configure tab.

5 Set selected CTLE setting as per table 83E-2.

6 Set clock recovery to First Order PLL with Loop BW = 10 MHz.

7 Measure Eye Height and Eye Width at 1E-6.

8 Compare and Eye Height to 95 mV and Eye Width to 460 mUI and report.

Eye Height B

The purpose of this test is to verify that all of the following CTLE settings Eye 
Height are greater than 80 mV. CTLE settings are:

1 Host Recommended CTLE

2 1 dB lower than optimal CTLE

3 1 dB higher than optimal CTLE
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PASS Condition The Eye Height measured is greater than 95 mV.

Measurement
Algorithm

1 To automatically find the optimal CTLE setting, first run the Find Optimal CTLE Eye 
Opening test unter Util ities (in the Select Tests tab). To manually set the optimal 
CTLE setting, select the setting under Use Optimized CTLE for Eye Opening in the 
Configure tab.

2 Select the Host Recommended CTLE setting in the config tabe "Host – 
Recommended CTLE value".

3 Obtain sample or acquire signal data.

4 Set memory depth to capture the number or UI set in the Configure tab.

5 Set CTLE setting to 1 dB lower than optimal.

6 Set clock recovery to First Order PLL with Loop BW = 10 MHz.

7 Measure Eye Height at 1E-6.

8 Repeat steps 3-7 with remaining CTLE settings – 1 dB lower than optimal CTLE 
and Host Recommended CTLE.

9 Compare all Eye Height measurements to 80 mV.
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Return Loss ENA/PNA Measurements

This section provides the Methods of Implementation (MOIs) for the Return Loss 
Measurements using a Keysight Infiniium oscilloscope, PNA or ENA, and the 
N8841A Compliance Test Application. The Compliance test application controls 
the PNA/ENA to set the test limits and run the test. The calibration must be done 
on the PNA/ENA.

Test Procedure 1 Start the automated test application as described in "Starting the Compliance 
Test Application" on page 13.

2 Calibrate the PNA or ENA.

3 In the Test application, click the Set Up tab. Select Measurement Option, Lane 
Option, and Channels.

4 Set up Switch matrix (if used) by clicking on the Switch Matrix Setup button.

5 Type in or select the Device Identifier as well as the User Description from the 
drop-down list. Enter your comments in the Comments text box.

6 Click the Select Tests tab and check the tests you want to run. Check the parent 
node or group to check all the available tests within the group.

7 Click Run. The test limits are automatically calculated.
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Figure 17 Selecting Return Loss Measurement
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5 CAUI-4 Module Output 
Characteristics at TP4

Main Voltage Measurements / 50
Transition Time Measurements / 53
Signaling Rate and Eye Mask Measurements / 55
Return Loss ENA/PNA Measurements / 59

This section provides the Methods of Implemenation for the CAUI-4 Host Output 
Characteristics at TP4 as specified in IEEE802.3bm Table 83E-3. Measurements 
are made at TP4.
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Main Voltage Measurements

This section provides the Methods of Implementation (MOIs) for the CAUI-4 Main 
Voltage Measurements using a Keysight Infiniium oscilloscope and the N8841A 
Compliance Test Application.

Probing and
Connection

You can use any of the oscilloscope channels as Signal source channel; however, 
for proper BW, use the Real Edge channels. Select lane options in the Set Up tab. 
You can identify the channels used for the measurement signal in the Set Up tab of 
the Compliance Test Application.

Test Procedure 1 Start the automated test application as described in "Starting the Compliance 
Test Application" on page 13.

2 Connect the probes to the signals on the DUT.

3 Connect the oscilloscope probes or cables to the channel(s) of the oscilloscope 
that you have set up in the Configuration tab.

4 In the Test application, click the Set Up tab. Select Measurement Option, Lane 
Option, and Channels.

5 Set up Switch matrix (if used) by clicking on the Switch Matrix Setup button.

6 Set up InfiniiSim if needed.

7 Type in or select the Device Identifier as well as the User Description from the 
drop-down list. Enter your comments in the Comments text box.

8 Click the Select Tests tab and check the tests you want to run. Check the parent 
node or group to check all the available tests within the group.

Figure 18 Probing for Main Voltage Measurements
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Specifications The CAUI-4 specifications can be found in IEEE 802.3bm section 83E.

• Differential Output Voltage (max 900 mV).

• AC Common Mode Output Voltage (max 17.5 mV).

• DC Common Mode Output Voltage (-350 mV – 2.85V).

Differential Output Voltage Test

The purpose of this test is to verify that the peak-to-peak voltage of the differential 
signal on a SQ8 or PRBS9 pattern is less than 900 mV.

PASS Condition The differential signal max peak-to-peak voltage on a SQ8 or PRBS9 pattern is 
less than 900 mV.

Measurement
Algorithm

1 Obtain sample or acquire signal data.

2 Verify that there is a signal is connected and has a SQ8 or PRBS9 pattern.

3 Measure the peak-to-peak voltage of the differential signal of DUT+ and DUT-.

Figure 19 Selecting Main Voltage Measurement Tests
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4 Compare the max peak-to-peak voltage to 900 mV.

AC Common Mode Output Voltage Test

The purpose of this test is to verify that the common mode signal of the differential 
pair rms voltage does not exceed 17.5 mV.

PASS Condition The signal is less than 17.5 mV.

Measurement
Algorithm

1 Obtain sample or acquire signal data.

2 Verify that there is a signal and that the connection is dual-single ended.

3 Measure the peak-to-peak voltage of the addition of the channel 1 and 3 or 
channel 2 and 4.

4 Compare the voltage measurement to 17.5 mV.

DC Common Mode Output Voltage Test

The purpose of this test is to verify that the common mode signal of the differential 
pair is between -300 mV to 2.85 V.

PASS Condition The signal is between -350 mV to 2.85 V.

Measurement
Algorithm

1 Obtain sample or acquire signal data.

2 Verify that there is a signal and that the connection is dual-single ended.

3 Measure the peak-to-peak voltage of the addition of the channel 1 and 3 or 
channel 2 and 4.

4 Compare the voltage measurement to -350 mV to 2.85 V.

NOTE This measurement can be done with a dual-single ended connection only; it cannot be done 
with a differential probing connection.

NOTE This measurement can be done with a dual-single ended connection only; it cannot be done 
with a differential probing connection.
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Transition Time Measurements

This section provides the Methods of Implementation (MOIs) for the CAUI-4 
Transition Time Measurements using a Keysight Infiniium oscilloscope and the 
N8841A Compliance Test Application.

Probing and
Connection

You can use any of the oscilloscope channels as Signal source channel; however, 
for proper BW, use the Real Edge channels. Select lane options in the Set Up tab. 
You can identify the channels used for the measurement signal in the Set Up tab of 
the Compliance Test Application.

Test Procedure 1 Start the automated test application as described in "Starting the Compliance 
Test Application" on page 13.

2 Connect the probes to the signals on the DUT.

3 Connect the oscilloscope probes or cables to the channel(s) of the oscilloscope 
that you have set up in the Configuration tab.

4 In the Test application, click the Set Up tab. Select Measurement Option, Lane 
Option, and Channels.

5 Set up Switch matrix (if used) by clicking on the Switch Matrix Setup button.

6 Set up InfiniiSim if needed.

7 Type in or select the Device Identifier as well as the User Description from the 
drop-down list. Enter your comments in the Comments text box.

8 Click the Select Tests tab and check the tests you want to run. Check the parent 
node or group to check all the available tests within the group.

Figure 20 Probing for Transition Time Measurements
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Specifications The CAUI-4 specifications can be found in IEEE 802.3bm section 83E.

• Minimum Output Rise Time (20%-80%) (min 12 ps).

• Minimum Output Fall Time (20%-80%) (min 12 ps).

Minimum Output Rise and Fall Time

The purpose of this test is to verify that the minimum rise and fall times are 12 ps.

PASS Condition The min rise and fall times are greater than 12 ps.

Measurement
Algorithm

1 Obtain sample or acquire signal data.

2 Verify signal is SQ8.

3 Measure rise and fall times from 20% to 80% of signal amplitude.

4 Compare the min rise and fall times to 12 ps.

Figure 21 Selecting Transition Time Tests
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Signaling Rate and Eye Mask Measurements

This section provides the Methods of Implementation (MOIs) for the Signaling Rate 
and Eye Mask Measurements using a Keysight Infiniium oscilloscope and the 
N8841A CAUI-4 Compliance Test Application.

Probing and
Connection

You can use any of the oscilloscope channels as Signal source channel; however, 
for proper BW, use the Real Edge channels. Select lane options in the Set Up tab. 
You can identify the channels used for the measurement signal in the Set Up tab of 
the Compliance Test Application.

Test Procedure 1 Start the automated test application as described in "Starting the Compliance 
Test Application" on page 13.

2 Connect the probes to the signals on the DUT.

3 Connect the oscilloscope probes or cables to the channel(s) of the oscilloscope 
that you have set up in the Configuration tab.

4 In the Test application, click the Set Up tab. Select Measurement Option, Lane 
Option, and Channels.

5 Set up Switch matrix (if used) by clicking on the Switch Matrix Setup button.

6 Set up InfiniiSim if needed.

7 Type in or select the Device Identifier as well as the User Description from the 
drop-down list. Enter your comments in the Comments text box.

8 Click the Select Tests tab and check the tests you want to run. Check the parent 
node or group to check all the available tests within the group.

Figure 22 Probing for Signaling Rate and Eye Mask Measurements
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Specifications The CAUI-4 specifications can be found in IEEE 802.3bm section 83E.

• Signaling Rate (25.78125 ±100 ppm GBd).

• Eye Mask.

• Eye Height (min 228 mV)

• Eye Width (min 570 mUI)

Signaling Rate

The purpose of this test is to verify that the data rate mean is between 25.78125 
±100 ppm GBd.

PASS Condition The mean signaling rate is between 25.78125 ±100 ppm GBd.

Measurement
Algorithm

1 Obtain sample or acquire signal data.

2 Check that signal is connected and data pattern exists (PRBS9 must be used 
for this test).

Figure 23 Selecting Signaling Rate and Eye Mask Measurements
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3 Set memory depth to capture the number or UI set in the Configure tab.

4 Set data rate measurement to semi-automatic 25.78125 Gb/s.

5 Measure min, max, mean data rate.

6 Report min and max values.

7 Compare and report the mean data rate value to 25.78125 ±100 ppm GBd.

Eye Height A and Eye Width

The purpose of this test is to verify that one of the optimal CTLE settings Eye 
Height is greater than 228 mV and Eye Width is greater than 570 mUI.

PASS Condition The Eye Height measured is greater than 228 mV and Eye Width is greater than 
570 mUI.

Measurement
Algorithm

1 To automatically find the optimal CTLE setting, first run the Find Optimal CTLE Eye 
Opening test unter Util ities (in the Select Tests tab). To manually set the optimal 
CTLE setting, select the setting under Use Optimized CTLE for Eye Opening in the 
Configure tab.

2 Obtain sample or acquire signal data.

3 Set memory depth to capture the number or UI set in the Configure tab.

4 Set selected CTLE setting as per table 83E-2.

5 Set clock recovery to First Order PLL with Loop BW = 10 MHz.

6 Measure Eye Height and Eye Width at 1E-6.

7 Compare and Eye Height to 228 mV and Eye Width to 570 mUI and report.

Vertical Eye Closure

The purpose of this test is to verify that the Vertical Eye Closure at EH15 (1E-15) is 
less than 5.5 dB.

PASS Condition The Vertical Eye Closure at 1E-15 is less than 5.5 dB.

Measurement
Algorithm

1 To automatically find the optimal CTLE setting, first run the Find Optimal CTLE Eye 
Opening test unter Util ities (in the Select Tests tab). To manually set the optimal 
CTLE setting, select the setting under Use Optimized CTLE for Eye Opening in the 
Configure tab.

2 Obtain sample or acquire signal data.

3 Set memory depth to capture the number or UI set in the Configure tab.

4 Set selected CTLE setting as per table 83E-2.

5 Set clock recovery to First Order PLL with Loop BW = 10 MHz.

6 Measure Eye Height at 1E-15 (EH15).

7 Measure and calculate AV as the mean value of logic 1 minus the mean value of 
logic 0 at the central 5% of the eye.



58 Keysight N8841A CAUI-4 Compliance Test Application Methods of Implementation

5 CAUI-4 Module Output Characteristics at TP4
 

8 Calculate and compare the VEC = 20log(AV/EH15).
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Return Loss ENA/PNA Measurements

This section provides the Methods of Implementation (MOIs) for the Return Loss 
Measurements using a Keysight Infiniium oscilloscope, PNA or ENA, and the 
N8841A Compliance Test Application. The Compliance test application controls 
the PNA/ENA to set the test limits and run the test. The calibration must be done 
on the PNA/ENA.

Test Procedure 1 Start the automated test application as described in "Starting the Compliance 
Test Application" on page 13.

2 Calibrate the PNA or ENA.

3 In the Test application, click the Set Up tab. Select Measurement Option, Lane 
Option, and Channels.

4 Set up Switch matrix (if used) by clicking on the Switch Matrix Setup button.

5 Type in or select the Device Identifier as well as the User Description from the 
drop-down list. Enter your comments in the Comments text box.

6 Click the Select Tests tab and check the tests you want to run. Check the parent 
node or group to check all the available tests within the group.

7 Click Run. The test limits are automatically calculated.
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Figure 24 Selecting Return Loss Measurement
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6 Debug Mode

Debug mode can be selected to enable the ability to change jitter measurement 
options. In the Configuration tab, select the Debug radio button. This will add the 
following options:

• Rj Band wid th — Choose the Rj Filter. Options are Narrow (Pink) or Wide (White). 
This changes the amount of DC jitter in the Rj measurement.

• Jitter Pattern Length — Choose Periodic or Arbitrary. Periodic is used for data 
patterns that are periodic and repeat through the oscilloscope memory. 
Arbitrary is used for random data patterns or long data patterns (for example, 
PRBS31) that do not repeat through the oscilloscope memory. If Arbitrary is 
selected, set the ISI filters.

• ISI Fil ter Lead — When using Arbitrary mode for the Jitter Pattern Length, set the 
Leading ISI filter coefficient. To help select the correct ISI filter, see Application 
Note 1574: Choosing the ISI Filter Size for EZJIT Plus Arbitrary Data Jitter 
Analysis (at www.keysight.com, literature part number 5989-4974EN).

• ISI Fil ter Lag — When using Arbitrary mode for the Jitter Pattern Length, set the 
Lagging ISI filter coefficient. Again, to help select the correct ISI filter, see 
Application Note 1574: Choosing the ISI Filter Size for EZJIT Plus Arbitrary 
Data Jitter Analysis.

http://literature.cdn.keysight.com/litweb/pdf/5989-4974EN.pdf
http://literature.cdn.keysight.com/litweb/pdf/5989-4974EN.pdf
http://literature.cdn.keysight.com/litweb/pdf/5989-4974EN.pdf
http://literature.cdn.keysight.com/litweb/pdf/5989-4974EN.pdf
http://literature.cdn.keysight.com/litweb/pdf/5989-4974EN.pdf
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A Calibrating the Infiniium 
Oscilloscope and Probe

Oscilloscope Internal Calibration / 64
Probe Calibration / 65

This section tells where to find information on oscilloscope and probe calibration 
procedures.
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Oscilloscope Internal Calibration

For information on performing the internal diagnostic and calibration cycle for 
your Keysight Infiniium oscilloscope, refer to the "User Calibration" topic in your 
oscilloscope's online help.
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Probe Calibration

Before performing the automated tests, you should calibrate the probes. 
Calibration of the solder-in probe heads consists of a vertical calibration and a 
skew calibration. The vertical calibration should be performed before the skew 
calibration. Both calibrations should be performed for best probe measurement 
performance.

For information on performing probe vertical and skew calibration in your Keysight 
Infiniium oscilloscope, refer to the "DC Attenuation/Offset Calibration" and "Skew 
Calibration" topics in your oscilloscope's online help.

For more information on calibration/deskew procedures for your particular probe, 
refer to the probe's user's guide in the Probe Resource Center.

http://www.keysight.com/find/prc
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